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1

Introduction

This document describes the integration between the Avaya Predictive Dialing System (PDS) and 
NICE Interactions Center. This integration enables Avaya Predictive Dialing System agents to be 
recorded and NICE Interactions Center to collect call details. 
This integration is the result of a need to record calls initiated by the Avaya Predictive Dialing 
System. In most cases, when a Predictive Dialing System is used, it is the only source for outbound 
call information. With this integration, NICE Interactions Center can record outbound calls based 
on NICE Interactions Center recording plans, Quality Assurance recording plans, and Recording 
On Demand initiated by an agent.
This integration is relevant for the following:
• NICE Interactions Center: NICE Perform 
• Avaya Predictive Dialer
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NOTE: Always check the Integration Description Document (IDD) regarding the latest 
upgraded versions.
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You are Here
You are Here

NOTE: 
Refer to the Site Installation Workflow Guide for a detailed overview of the NICE Perform 
site installation workflow.
The Site Installation Workflow Guide provides general guidelines and procedures for 
installing NICE Perform at your site, and indicates the exact point during site installation 
at which to perform switch integrations.

NiceLog High Density Logger

Install SQL + Databases

Interaction Capture Unit (ICU)

Mandatory
component 

Optional
component

Legend Prepare Machines 

Connect

Install relevant optional components:

Define in System Administrator

NICE VoIP Logger

Perform Required Installation and Acceptance Test Procedures

Define in System Administrator

Install NICE Perform Applications

Define in System Administrator

Define in System Administrator

Define in System Administrator

Install NMS

Install and Configure Switch Integrations

Install NICE Interactions Center

Install VoIP Recording Gateway (VRG)

You are Here

NiceScreen
ScreenSense
Reporter Server

NICE Storage Center
Media Library
Playback Server and/or Feedback

Audio Analysis

Define Channel Mapping in the System Administrator
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Avaya Predictive Dialer Integration Workflow
Avaya Predictive Dialer Integration Workflow
The following flow details the components required in the Avaya Predictive Dialer integration. 

Configuring the CTI Interface

Configuring the Connection Manager

Installing the NICE Integration Software

An Avaya System Administrator must be present during the installation to 
assist with this phase of the installation!

Preparing the Avaya PD Environment

Legend:

Mandatory 
component (with 
link to procedure 
in this 
publication)

Optional 
component

Defining the Driver
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Terms and Concepts
Terms and Concepts

For more information regarding Avaya Predicative Dialing concepts, see Predictive Dialing 
System Call Flows on page 19.

Table 1-1:  Terminology Used in This Document 

Term Description

ACD Automatic Call Distributor

Blended Environment Predictive Dialing System that integrates both inbound and 
outbound call routing.

Blending The way in which inbound and outbound calls are routed to the 
agent.

CORBA Common Object Request Broker Architecture: OMG's open, 
vendor-independent architecture and infrastructure that computer 
applications use to work together over networks. Using the standard 
protocol IIOP, a CORBA-based program from any vendor, on almost 
any computer, operating system, programming language, and 
network, can inter-operate with a CORBA-based program from the 
same or another vendor, on almost any other computer, operating 
system, programming language, and network. 

Enserver Application that runs on Avaya Predictive Dialing System 
responsible for sending CTI events to NICE Interactions Center via 
CORBA.

Overflow Environment Scenario where the PD dials outbound calls until inbound flow 
exceeds outbound. When inbound flow exceeds outbound, the PD 
stops outbound calls until inbound pressure lets up.

Overflow Inbound 
Mode

Agent logs into the PD and all call routing is performed via the PD. In 
this implementation, headset connection remains intact. The PD can 
be configured as the agent and receive inbound calls overflowing 
from the ACD queue.

PD Predictive Dialing 

PDS Predictive Dialing System

Predictive Inbound 
Mode

Agent logs in as an ACD agent, accepting inbound calls through the 
ACD. When switching to outbound mode, the agent logs into the PD. 
During this time, the agent does not receive any inbound calls from 
the ACD, even though he or she is still logged in as an ACD agent. 
When logging out of the PD, the agent resumes receiving inbound 
calls from the ACD.
12 Chapter 1: Introduction
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Terms and Concepts
Avaya Predictive Dialing System Concepts

Agent Types

Below are the agent types supported by Avaya PD:

• Outbound agent – The outbound agent receives calls initiated by the Avaya PD. The Avaya 
PD dials calls routed outbound and records the statistics of all calls. 

• Inbound agent – Agent who receives inbound calls only.

• Blended agent - Agent who handles both inbound and outbound calls. 

For details about the blended environment, see Blending Types on page 13.

• Managed agent – The agent previews customers’ files and determines for the Avaya PD 
which outbound number to call. The Avaya PD calls one number at a time and displays the 
corresponding customer’s record on the agent’s screen. 

Following are three types of managed agents: 

• The agent waits for the Avaya PD to initiate calls. 

• The agent initiates calls through the Avaya PD.

• The agent cancels the customer’s record that is displayed on his screen, and moves to the 
next record. The agent may repeat this process until he initiates a call through the Avaya 
PD.

• Manual call – The Avaya PD initiates an outbound call which the agent handles. However, the 
call is answered by someone who is not the customer, and who refers the agent to another 
phone number. In this situation, the agent manually initiates a new outbound call and dials the 
new number. 

Blending Types

Blending refers to the way in which the agent receives inbound and outbound calls. Blending 
mixes the inbound and outbound calls, enabling the agent the ability to handle both types of calls. 

Intelligent Call Blending (Overflow Call Blending)

This is the standard call blending type for the Avaya PD. In the Intelligent Call Blending system, 
the blended agent handles outbound calls until there are more inbound calls than available inbound 
agents. In this case, the Avaya PD passes the excess inbound calls to the blended agents. When the 
call volume decreases, the Avaya PD reverts to passing outbound calls to blended agents.

Agent Blending (Truly Blended Inbound Overflow)

This is an enhanced call blending system that requires an Automatic Call Distributor (ACD) and 
Computer Telephony Integration (CTI) server. Avaya PD integrates outbound call activities with 
inbound call activities on the ACD. The ACD agents log into the Avaya PD and the ACD. The 

NOTE: Intelligent Call Blending does not require a special configuration. This system 
does not require a CTI Server.
13 Chapter 1: Introduction
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Terms and Concepts
Avaya PD monitors the activity on the ACD and uses this information to determine when to 
acquire and release ACD agents from a pool of blended agents. Agent Blending can be 
implemented in two ways: predictive or proactive.

• Predictive Agent Blending

Predictive Agent Blending focuses on inbound call traffic. In this environment, by default, 
agents accept inbound calls until the Avaya PD predicts that there will be too many agents 
accepting inbound calls. At this point, the Avaya PD acquires agents from the ACD for 
handling outbound calls until the inbound volume increases.

• Proactive Agent Blending

Proactive Agent Blending focuses on outbound call traffic. In this environment, the Avaya PD 
releases agents to inbound calls when inbound calls enter the queue on the ACD. When an 
agent completes an inbound call, Avaya PD acquires that agent for outbound calls once again.

NOTE: If the contact center site has an ACD, either one of the blending methods can 
be used. However, both methods cannot reside on the same Predictive Dialing System.
14 Chapter 1: Introduction
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System Architecture
System Architecture
Avaya Predictive Dialing System is a call management system which supports both centralized 
and distributed call centers. 

Successful calls, calls that were not answered by an answering machine, busy tone, or not at home 
tone, are called hits. Using these call statistics, the Avaya PD simultaneously initiates calls, 
maximizing the time an agent is actively involved in a call (meaning, talking to a person and not to 
a machine).

Avaya PD performs the following tasks:

• Receives customer records from the call center’s host computer

• Selects and sorts customer records based on the call center’s business goals

• Allows agents to update customer information on an agent screen or on the host

• Transfers specific call types to agents

• Adjusts the calling pace to meet the call center’s requirements

• Monitors ACD inbound traffic and predicts when to acquire and release ACD agents for 
outbound calls

• Supports outbound, inbound, and blended environments

• Generates job, agent, and system reports

• Uploads record information to the host

NOTE: This integration describes using the PD in Digital mode. It is not relevant for the 
integrations using the PD in CTI mode. If operating in CTI mode, there is no need to use 
the PD driver. The configuration should be made using Avaya CT. Refer to the 
Integrating with Avaya CT guide.
15 Chapter 1: Introduction
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System Architecture
Figure 1-1   System Architecture

Components

Avaya PD

• Avaya Predictive Dialing System (PDS): Avaya 

Avaya PD includes the following components:

• PD server: Dialing server that automatically dials the Customer Call Center based on a 
predefined scheduled campaign. 

• PD Agent: Application running on the agent desktop and used by the agent to login to the 
dialer.

• PD Editor and Monitor: Used by the PD administrator for configuring, running the 
campaign and monitoring agents activity. 

• PD Event Service: The NICE client connects to the Event/Naming services on the PD 
and receives agent activity and call events from this service.

• Used to send the call event to the NICE client. The NICE client connects to and receives 
agent activity and call events from this service.

• PG230: E1/T1 interface connecting to the ACM.

IP PhonesE1/T1 Trunks

Avaya PD server

LAN

NICE Interactions Center

NICE Environment

AVAYA PD Environment Avaya 
Communication 
Manager (ACM)

Avaya PD agent
E1/T1 Trunks

Logger

Media 
Gateway

Media Server

Media Server

Event Server
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System Architecture
• Avaya Communication Manager (ACM): Avaya call processing software.

The ACM includes the following components:

• Media Server: The Media Server runs the ACM software, and performs real-time 
management of the calls.

• Media Gateway: The Media Gateway performs signaling and audio conversion. It is 
controlled by the Media Server and hosts the interface cards (analog, digital, CLAN, 
MedPro and so on).

NICE Perform Release 3

• NICE Interactions Center: The NICE Interactions Center, using the CTI Driver's 
Information, sends commands to start/stop call recordings. It stores the call information in its 
databases and controls the various recording programs. The NICE Interactions Center 
communicates with the CTI server via the Event Server. In this way, the NICE Interactions 
Center learns the call status, monitors call events and stores them in its database. Users can 
then run queries to find and play back a call. 

• Logger: NiceLog is a powerful digital voice logging system. NiceLog Loggers continuously 
and simultaneously record and archive audio from multiple sources. Audio is recorded to the 
hard drive of the Logger for immediate playback capability.

• NICEScreen (Logger) Server: NiceScreen Logger operates as a service which runs 
continuously on a dedicated server, managing screen captures received from NICE 
ScreenAgents. It can be installed on any user-supplied machine that meets system 
requirements. Each NiceScreen Logger can record up to 250 input channels and play back up 
to 50 recordings simultaneously. You can install at your site as many NiceScreen Loggers as 
necessary; each NiceScreen Logger maintains its own storage system. Using NICE 
Administrator, you can configure different Loggers to record screens from different 
workstations. The recording is controlled by NICE Interactions Center. 
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Recording Methods
Recording Methods
Integration of the NICE Interactions Center and the Avaya Predictive Dialer can be carried out 
using the following recording methods:

• Trunk-side recording - NiceLog connects to trunks. This is the trunk between the Avaya 
switch and Avaya PD. This connectivity is used for Total Recording and Selective Recording. 
See Trunk-Side Recording Architecture on page 22 for details. 

• Extension-side recording - NiceLog connects directly to the extensions and taps them. This 
connectivity is usually used for Total Recording. See Extension-Side Recording 
Architecture on page 23 for details.

Recording Modes

Depending on your CTI switch configuration, the following recording modes are available:

NICE Interactions Center supports the recording of all Avaya PD agent types and job types, 
including extension-side recording and trunk-side recording.

• Total Recording Records all calls for all connected inputs: All calls 
(agent-to-customer, customer-to-agent, and agent-to-agent) are 
recorded. This type of recording is used for resolving disputes. 

When Total Recording is implemented in a Trunk-side 
configuration, internal (agent-to-agent) calls are not recorded.

• Interaction-Based 
Recording

Records selected calls (interactions) based on filter criteria: The 
user selects complete or parts of calls to be recorded according 
to a predefined schedule or criteria (for example, calls to and 
from the sales department).

Interaction-Based Recording can be:

• Rule-Based

• Statistical for QM

• ROD (Recording on Demand)
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Recording Methods
Predictive Dialing System Call Flows

This section describes the following call flows in the Avaya PD environment:
• Outbound Call Flow
• Simple Inbound Call Flow
• Overflow Blended Inbound Call Flow

Outbound Call Flow

Figure 1-2   Schematic Diagram of the Outbound Call Flow

Referring to Figure 1-2, the outbound call flow operates as follows:
1. The agent logs into the Avaya PD via his soft phone or the PD application and at the same time 

logs into the ACM extension.

NOTE: The call flows described in this section assume that a CTI server exists at the 
site.
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Recording Methods
The Avaya PD calls the agent. From now on, this call remains open as long as the agent’s 
phone remains off-hook. 

2. The agent is joined to a PD campaign/job.
3. The Avaya PD dials outbound to a customer. When a customer answers the call, the Avaya PD 

directs the call to an available agent. 
The NICE PD driver receives the CTI information from these outbound calls from the Avaya 
PD Event Service. 

Simple Inbound Call Flow

Figure 1-3   Schematic Diagram of the Inbound Call Flow

Referring to Figure 1-3, the inbound call flow operates as follows:
1. The customer calls the agent.
2. The agent answers the call.

This call does not go through the Avaya PD. The NICE Avaya Generic driver receives the CTI 
information for this call via the ACM.

NOTE: In the standalone environment (site with no Avaya switch), the Avaya PD 
functions as the switch. In this case, the NICE PD driver receives the CTI information 
via the Avaya PD.
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Recording Methods
Overflow Blended Inbound Call Flow

Figure 1-4   Schematic Diagram of the Overflow Blended Inbound Call Flow

Referring to Figure 1-4, the overflow blended inbound call flow operates as follows:

1. The Avaya PD detects overflow of inbound calls.

2. The Avaya PD stops initiating outbound calls, however, leaves the connection to the agent 
open.

3. Inbound calls are directed by the Avaya PD to the agent via the outbound line. This is called 
the overflow trunk. 

The NICE PD driver receives the CTI information for these inbound calls from the PD Event 
service.
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Recording Methods
Trunk-Side Recording Architecture

The NiceLog Logger supports Trunk-side recording using the Total Recording or Dynamic/Static 
Selective Recording methods. In Trunk-side recording systems, NiceLog Loggers receive and sum 
the E1/T1 trunk inputs, and record them.

The Avaya switch sends the Trunk ID to the NICE Interactions Center via the PD server. NICE 
Interactions Center also receives call data that can be used in queries to retrieve specific calls.
Figure 1-5   Trunk-Side Recording Configuration 

Components

For information regarding system components, see Components on page 16.

Supported Trunks

The following trunk types are supported:
• ISDN-PRI
• CO
• Tie

IMPORTANT
Always check the Integration Description Document (IDD) regarding the latest upgraded 
versions for Trunk-side recording.
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Recording Methods
Extension-Side Recording Architecture

The NiceLog Logger supports Extension-side recording. 

The Loggers are configured to passively tap the lines connecting the phonesets to the PABX. Each 
Logger stores these recordings locally for immediate playback. This is later moved for long-term 
storage. 

• NICE Interactions Center builds its nice interactions database based on the CTI data that it 
receives from the PD.

• Users and/or applications can query the nice interactions database, which are connected to 
the NICE Interactions Center via the LAN/WAN.

Figure 1-6   Extension-Side Recording Configuration

In a site with Extension-side Selective Recording, only those calls or lines that are defined as part 
of a recording program are recorded. Users can choose to record only incoming calls, calls for a 
number based on DNIS, calls handled by an agent or group of agents, calls from a predefined 
number, outgoing calls to a specific number, and local calls. Extension-side Interaction-based 
Recording is implemented when there is a requirement to record most extensions concurrently.
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Supported Database Fields
• The NiceLog Logger is connected to each switch extension that the customer wants to 
record. The Logger input is connected to the main Distribution Frame (MDF). 

• The CTI server sends call data in real time as each call is initiated. The NICE Interactions 
Center determines whether or not to record the call.

Components

For information regarding system components, see Components on page 16.

Supported Database Fields

The following database fields are supported and can be queried:

• Station

• Phone Number (ANI)

• Direction

• Call ID

• Agent ID 

• DNIS (Dialed In)

• Trunk Information

• User Data - this information is site-dependent

Business Data Support

The Avaya Predictive Dialer supports the following business data:

• User Specific Business Data

• Fixed Business Data

User Specific Business Data

The User Specific business data is also called USERDATA or IDENT, which is one of the CTI 
fields that the Avaya PD interface displays.

In total, there are four business data fields available for customer use.

NOTE: All the fields depend on whether the switch reports this information!
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Fixed Business Data

In addition to the user specific business data, the Avaya PD integration reports the following fixed 
business data for each call:

1. CompletionCode: Completion code value that an agent assigns when releasing a customer 
record.

2. OriginalCID: The original call ID number that was assigned by the Avaya Predictive Dialer 
server.

3. JobName: Identifies the name of the job to which the agent is assigned.

4. JobNumber: The job number assigned by the dialer server.

5. TypeOfJob - The job type. This can be one of the following: 

• OUTBOUNDJOB

• INBOUNDJOB

• MANAGEDJOB

• BLENDJOB

To save these fields in the database, you must map the exact names as shown above in the 
Database server plug-ins. 
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General Limitations
Avaya PD standalone Integration with Aspect PABX in Extension-side recording

When the Avaya PD standalone integration is used together with Aspect PABX, extension side 
recording is not supported due to the Avaya PD server reporting the Aspect agent ID instead of the 
instrument ID in the extension field.

Avaya PDS 11 is not supported

Avaya PDS 11 is not supported due to Avaya changing their Common Object Broker Architecture 
(CORBA) Orbix interface in version 11 to the TAO CORBA interface in version 12. The current 
CTI integration is based on the TAO interface.

Switch Driver in Extension-Side Recording

In this setup, you need 2 channels in the logger for each extension as the dialer is configured with 
its own switch ID.

Recording Problems in the Multiple Driver System

Long Call Problem

Problem: Referring to Typical Agent Workflow in a Contact Center on page 116, the Avaya 
PD agents use a dedicated Avaya PD workstation to log into the Event Server. In the typical 
connectivity scenario, the Avaya PD registers the agents and gives them an internal extension to 
call. The agents complete the login process by answering the phone, which is a dedicated Avaya 
PD port (establishing a headset connection). This port stays off-hook and captures the agent for an 
outbound session. To the PABX, this looks like a long internal call. 

Solution: The Rejected Device feature in the CTI driver configuration in the System 
Administrator addresses this issue. This feature enables you to define the trunk connected to the 
Avaya PD as a Rejected Device. This prevents the CTI driver from opening the Long Call. 
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Preparing the Avaya PD Environment 

This chapter provides guidelines for installing the Avaya PD CTI link.

Contents

Installing the Avaya PD CTI Link ...................................................................................28

Receiving Trunk Information .........................................................................................29

Retrieving the Avaya PDS Agent ID ..............................................................................30
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Installing the Avaya PD CTI Link
Installing the Avaya PD CTI Link
Before starting the integration of Avaya PD with NICE Perform, do the following:

• In the Host file on the Interactions Center, map the Event Server IP address to its host name. 
For example, in NICE this is 192.168.243.148 cpu1.eventserver.pds.com.

Figure 2-1   Host File

NOTE: Ask for the fully qualified domain name from the Avaya engineer on-site.

map the Event 
Server IP 
address to its 
host name
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Receiving Trunk Information
Receiving Trunk Information
To configure the switch to receive the trunk information, follow the procedures below.

To configure the time slots for trunk side recording:

1. Request the dgswitch.cfg file from the Avaya switch engineer on-site.

2. Copy the time slots number from the Headset Ports (Agent ports), see Figure 2-2.
Figure 2-2   Dgswitch.cfg File

CTI Trunk ID 

CTI time slots

Logger Time 
slots

IMPORTANT 
This file is very important for configuring Channel Mapping. 
When configuring Channel Mapping, the time group should be 0. (This can change from site to 
site.) Define the time slot according to the dgswitch.cfg switch — in particular refer to the 
Headset port information. The trunk position number should be typed in the Logger Timeslot. 
For more information regarding Channel Mapping, see the NICE Channel Mapping Guide.
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Retrieving the Avaya PDS Agent ID
Retrieving the Avaya PDS Agent ID
You can retrieve the Avaya PDS agent ID by following the procedures below.

How to get the Avaya PDS agent ID:

1. Login into the Avaya PDS via telnet.
Figure 2-3      Telnet.exe - Login

2. To change the folder to etc, type cd /etc and press <Enter>.

3. To view the file password, type vi passwd and press <Enter>.
Figure 2-4      Telnet.exe - Changing Folder and Viewing Password

The line agent1:z1odNs5/v1eTw:107 in Figure 2-5 on page 31 means that the agent 
name is agent1 and the agent ID that the Avaya PDS driver receives is 107, see below.

To change 
the folder to 
etc, type 
“cd /etc” 

To view the password, 
type “vi passwd”
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Retrieving the Avaya PDS Agent ID
Figure 2-5      Driver - Interface Configuration Window

Agent name 
is “agent1”

Agent ID is 
“107”
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3

Integrating Avaya Predictive Dialer with 
NICE Perform

This chapter describes the procedures for integrating Avaya Predictive Dialer with NICE Perform 
Release 3.

Contents

Before you Begin............................................................................................................34

Configuring the CTI Interface ........................................................................................36

Configuring the Connection Manager ..........................................................................42
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Installing the NICE Integration Software ......................................................................51

IMPORTANT 
You must install and configure the Avaya Predictive Dialer before you install and configure the 
NICE Perform integrations.
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Before you Begin
Before you Begin
Configuration Information

To configure the NICE Perform Integrations, you run a series of configuration wizards. Each 
configuration wizard requires you to enter relevant information. 

Before running the configurations wizards, you must obtain the necessary information for each of 
the following configuration wizards:

• CTI Interface Configuration

• Connection Manager Configuration

• Driver Configuration

CTI Interface Configuration

Before proceeding with Configuring the CTI Interface on page 36, have ready the following 
information:

• Avaya PD version

• Avaya PD server IP Address

• Avaya PD Event Service host name

• Avaya PD Naming Service host name

• Avaya PD client user name (usually client1 - but you need to verify it with the System 
Administrator)

• Avaya PD client password (usually server1 - but you need to verify it with the System 
Administrator)

• For trunk-side recording, dgswitch.cfg from the Avaya engineers

• Avaya PD agents login list

• Recording Method

Connection Manager Configuration

Before proceeding with Configuring the Connection Manager on page 42, have ready the 
following information:
• The name, port, and ID number of the Connection Manager
• The IP address or Host Name where the Connection Manager is installed
• Reporting levels for all messages, if different from the defaults

NOTE: It is important that the CTI System Administrator is present during the 
installation to assist with this phase of the installation.
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Before you Begin
• If any Connection Manager parameters need to be defined, their names and values
• The Interfaces that will be connected to the Connection Manager and any parameters and their 

values that might need to be customized.

Driver Configuration

Before proceeding with Defining the Driver on page 46, have ready the following information:
• The name and ID number of the driver
• The IP address or Host Name where the driver is installed
• The NICE Interactions Center servers connected to the driver
• Reporting levels for all messages, if different from the defaults
• If any driver parameters need to be defined, their names and values
• The Interface that will be connected to the driver.

SNMP Service

Before installing the integration software make sure that the SNMP Service is installed on your 
computer.

Configuring the Integration Package

This section describes the Integration Package configuration procedures.
To integrate the Avaya Predictive Dialer driver to support recording, perform the following 
procedures:
• Configuring the CTI Interface
• Configuring the Connection Manager
• Defining the Driver
• Installing the NICE Integration Software
All system components must also be associated with each other appropriately.

IMPORTANT 
Verify that you have entered the Event Service host name in the hosts file under 
c:\Windows\system32\drivers\etc.
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Configuring the CTI Interface
Configuring the CTI Interface
The CTI Interface defines the actual CTI server to which the system will integrate. For every 
interface, a switch is configured. This is the physical server on which the interface is installed. 
More than one interface may be installed on the same switch, so when configuring the interface, 
the correct switch must be defined.

You begin the NICE Perform configurations by configuring the CTI Interface.

Logging in to the System Administrator

This procedure describes how to log in to the System Administrator.

To log in to the System Administrator:

1. Open the System Administrator, as follows:

a. Log in to the NICE Perform Applications Suite.

b. From the Accessories menu, choose System Administrator. 

The System Administrator appears with a list of NICE components under the Site branch 
in the Organization tree.

To add components in the System Administrator, you must work in Technician Mode.

2. Set the System Administrator to Technician Mode:

a. In the Organization Tree, select the Organization branch. 

b. Mark the Technician Mode checkbox and click Save .

Creating a CTI Interface

This procedure describes how to create a CTI interface.
36 Chapter 3: Integrating Avaya Predictive Dialer with NICE Perform

NICE Perform® Release 3: Integration with Avaya PD/PDS (Rev. A0)



Configuring the CTI Interface
To create a CTI interface:

1. In the System Administrator, in the Organization tree, navigate to Master Site > CTI 
Integrations and select CTI Interfaces.

2. From the Actions menu, choose New CTI Interface.
Figure 3-1   Selecting New CTI Interface

The Set New CTI Interface Wizard window appears.
Figure 3-2   Set New CTI Interface Wizard - Introduction Window

3. Click Next. The Set New CTI Wizard Step 1 of 3 window appears displaying the Choose CTI 
Interface section.
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Configuring the CTI Interface
Figure 3-3   Choose CTI Interface Section

a. In the Telephone switch and CTI Interface Type area, click the Telephony switch 
drop-down list and choose Aspect PC/PDS.

b. Click the CTI Interface drop-down list and select Event Service. 

c. Click Apply.

The Name and Physical Switch fields become enabled and the Create button appears.
Figure 3-4   Choose CTI Interface Area

Click 
Apply 

Click 
Create 
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Configuring the CTI Interface
d. In the Name field, type the new interface name. 

e. Select the Physical Switch:

• To create a new physical switch, click Create. The New Physical Switch window 
appears. Continue with step numbers 4 and 5.

• To use an existing switch, continue with step number 5.
Figure 3-5   New Physical Switch Window

4. To create a New Physical Switch:

a. In the Switch Name field, type a name for the switch.

b. In the Physical Switch ID field, type a switch ID.

c. In the CLS Reporting Type field, leave CTI as the default setting.

d. To enable non-standard NICE CLS log-in options, in the Agent Logon Mode area, 
leave the default checkboxes marked:

Marking To the same station again - allows agents to log in to the same workstation 
more than once.

Marking To more than one station - allows agents to log in to more than one 
workstation.

IMPORTANT 
When working in multiple driver systems, each driver has to have its own physical switch ID 
number. 

NOTE: Give the Physical Switch a unique ID.
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Configuring the CTI Interface
Marking To a station another agent is logged into - allows more than one agent to log 
in to one workstation.

e. Click OK. The newly created physical switch now appears in the Physical Switch list. The 
General Interface Information window reappears.

5. Click the Physical Switch list and choose the relevant physical switch.

6. Click Next. The Set New CTI Wizard Step 2 of 3 window appears displaying the General 
Switch Info section.
Figure 3-6   General Switch Info Section

a. Expand Switch Connection Details. The Switch Connections Details area appears.

NOTE: It is recommended that you leave all three Agent Logon modes marked.
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Configuring the CTI Interface
Figure 3-7   Switch Connection Details Area

b. To define the existing parameters or to create new ones, see CTI Interface - Switch 
Connection Details Parameters on page 98.

7. Click Next. The Summary window appears.
Figure 3-8   Summary Window

8. Click Finish. The CTI interface is created.
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Configuring the Connection Manager
Configuring the Connection Manager
The Connection Manager is used for creating and maintaining the CTI link. The connection 
manager is used as a pipeline for transferring information between the interface and the driver/s, 
once the link is established. One Connection Manager can be used to connect to several Interfaces 
and can have several Drivers.

After configuring the CTI Interface, you must configure the Connection Manager to the Avaya PD 
link you created in the CTI Interface.

The Connection Manager module will interface with the switch to receive all of the relevant CTI 
events and information.

To configure the Connection Manager:

1. In the Organization tree, under Master Site > CTI Integrations, choose Connection 
Managers.

2. From the Actions menu, choose New Connection Manager.
Figure 3-9      Actions Menu

The Set New Connection Manager Wizard starts.

IMPORTANT 
If you are using the Avaya PD switch in conjunction with another integration, you must configure 
a Connection Manager for each switch.

IMPORTANT 
To configure the Connection Manager, you must have permission to work in Technician Mode, 
see Logging in to the System Administrator on page 36. You do not need Technician Mode 
privileges to view information.
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Configuring the Connection Manager
Figure 3-10      Set New Connection Manager Wizard - Introduction Window

3. Click Next. The Set New Connection Manager Wizard Step 1 of 3 window appears displaying 
the General Details area.
Figure 3-11      General Details Area

a. In the Name field, type the name you want to give the Connection Manager.
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Configuring the Connection Manager
b. Accept the default port number. 

c. In the ID field, type the ID number you want to give the Connection Manager.

d. In the Location area, select either the IP Address or the Host Name of the computer on 
which the Connection Manager is located.

4. It is recommended to accept the existing defaults for the Connection Manager’s Reporting 
Levels. 

If it should be necessary to make changes, see Reporting Levels on page 102. 

5. It is recommended to accept the existing defaults for the Connection Manager’s Additional 
Parameters. 

If it should be necessary to define existing parameters or to create new ones, see Connection 
Manager - Additional Parameters on page 104.

6. Click Next. The Set New Connection Manager Wizard Step 2 of 3 window appears displaying 
the Attach CTI Interfaces section.
Figure 3-12      Attach CTI Interfaces Section

All available CTI Interfaces are listed in the Available Interfaces list.

a. Select the interface(s) you want to attach and click the arrow to transfer the interface(s) to 
the Attached Interfaces list. 

b. It is recommended to accept the existing defaults for the Connection Manager - 
Interface Parameters. 

If you need to define existing parameters or to create new ones, see Connection Manager 
- Interface Parameters on page 106.

NOTE: Do not change the default port number.

Choose the 
interface you 
want to 
attach
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Configuring the Connection Manager
7. Click Next. The Summary window appears.
Figure 3-13      Summary Window

The Summary window displays the Connection Manager name and ID. 

8. Click Finish to create the Connection Manager. 

Upon completion the System Administrator page reappears and the new Connection Manager 
appears in the list of Connection Managers.

NOTE: For details pertaining to maintaining or changing the Connection Manager or 
any of its definitions, refer to the NICE Perform System Administrator’s Guide.
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Defining the Driver
Defining the Driver
The driver is used to get the actual events from the Interface via the Connection Manager. When 
the driver receives these events, they are filtered and translated into CAPI commands (start call, 
end call) or discarded, according to the system configuration (recording rules, CTI analysis 
installed, and so on).

After configuring the Connection Manager, you create the driver and connect it to the Connection 
Manager. 

To create the driver:

1. In the System Administrator, in the Organization tree, navigate to Master Site > CTI 
Integrations and select Drivers.

2. From the Actions menu, choose New Driver.
Figure 3-14      Actions Menu

The Set New Driver Wizard starts.

IMPORTANT
To define the driver, you must have permission to work in Technician Mode, see steps 1 
through 3 on page 36. You do not need Technician Mode privileges to view information.

NOTE: The driver needs to be associated with a Connection Manager. This is only 
possible after you have defined the Connection Manager, see Step 9 on page 49.
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Defining the Driver
Figure 3-15   Set New Driver Wizard - Introduction Window

3. Click Next. The Set New Driver Wizard Step 1 of 3 window appears displaying the General 
Details area.
Figure 3-16      General Details Area

a. In the Name field, type the name you want to give the driver.

b. In the ID field, type the ID number you want to give the driver.

c. Under Driver’s Location, select either IP Address or Host Name and type the 
computer on which the NICE Integrations are installed.

Type the 
location
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4. Expand Attach CLS. The Attach CLS area appears.
Figure 3-17   Attach CLS Area

All available CLS servers are listed in the Available CLS list. 

5. Select the CLS server(s) you want to attach and click the arrow to transfer the CLS server to 
the Attached CLS list.

6. It is recommended to accept the existing defaults for the new Driver Reporting Level 
parameters. 

7. It is recommended to accept the existing defaults for the New Driver’s Additional Driver 
Parameters. 

If it should be necessary to define existing parameters or to create new ones, see Driver - 
Additional Driver Parameters on page 109.

8. Click Next. The Set New Driver Wizard Step 2 of 3 window appears displaying the Attach 
CTI Interfaces section.

NOTE: Setting up the reporting level is similar for all the different Integration components.
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Figure 3-18      Attach CTI Interfaces Section

9. To attach the CTI interface:

a. In the Attach CTI Interfaces section, mark the checkbox for the CTI Interface you want 
to attach to this driver. 

NOTE: After creating the Connection Manager and the driver, you must specify the 
switch (CTI Server) with which this Connection Manager will be associated. In this 
case, the Connection Manager will be associated with the Avaya Predictive Dialer CTI 
interface created previously, see Configuring the CTI Interface on page 36.

NOTE: When you mark the checkbox for the CTI Interface, the checkbox for the 
corresponding Connection Manager automatically becomes marked as well. You 
cannot mark the checkbox of the Connection Manager by itself.

Mark the 
checkbox 
for the CTI 
Interface
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Figure 3-19   Attach CTI Interfaces Section

10. Click Next. The Summary window appears.
Figure 3-20      Summary Window

The Summary window displays the driver name and ID. 
11. Click Finish to create the new driver.The System Administrator page reappears and the new 

driver appears in the list of drivers.

NOTE: For details pertaining to maintaining or changing the driver or any of its 
definitions, refer to the NICE Perform System Administrator’s Guide.
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Installing the NICE Integration Software
After performing all the above configurations, you now install the NICE Integration software on 
the NICE Interactions Center server. 

To install the integration software:

1. Insert the NICE Perform CTI Integration Suite Installation CD in the CD-ROM drive.

2. Navigate to the Integration installation program and double-click Setup.exe.

The NICE Perform CTI Wizard starts.
Figure 3-21   NICE Perform CTI - InstallShield Welcome Window

3. Click Next. The Choose Destination Location window appears.

NOTE: The SNMP service must be installed BEFORE you can configure this software.
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Figure 3-22   Choose Destination Location Window

4. To change the default installation path, click Browse and select the required path. 

5. Click Next. The Select Integrations window appears.
Figure 3-23   Select Integrations Window

b. Expand Avaya PC/PDS.

Mark: Event 
Service

Expand: 
Avaya 
PC/PDS
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c. Mark Event Service. Both Avaya PC/PDS and Event Service are marked.

d. Click Next. 

The System Administrator Server Location window appears.
Figure 3-24   System Administrator Server Location Window

The associated Port number (62070) appears by default. 
6. Type the location of the System Administrator service. 
7. Click Next. The Setup Type window appears.

Type the System 
Administrator 
service location

Port number 
62070 appears 
by default.
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Figure 3-25   Setup Type Window

e. If your site is configured for a network user account, leave the default setting. 
-or-
If you need to configure for a local system account, select Local System Account. 
Continue with Step 10.

f. Click Next. The Network User Account Setup window appears.

Select the
relevant System 
Account
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Figure 3-26   Network User Account Setup Window

• To define an existing network user, continue with Step 8.

• If no user exists or to add an additional new user, continue with Step 9.

8. To define an existing network user, in the User name area, click Browse. The Browse for a 
User Account window appears.
Figure 3-27   Browse for a User Account Window

a. In the Domain or server area, click Browse. The Select a Domain or Server window 
appears.

Click Browse to 
define an 
existing network 
user

If no network user exists, click 
New User
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Figure 3-28   Select a Domain or Server Window

b. Select a domain or server and click OK.
c. In the Browse for a User Account window, in the User name area, click Browse. The 

Select a User Name window appears.
Figure 3-29   Select a User Name Window

d. Select a user name, and click OK. The Network User Account setup window reappears.

Select the
relevant domain or 
server

Select the
relevant user name
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Figure 3-30   Network User Account Setup Window

e. In the Network User Account setup window, in the Password field, type the password 
provided by the site administrator.

9. If no user exists or to add an additional new user, click New User. The New User Information 
window appears.
Figure 3-31   New User Information Window

• Complete all fields and click OK.

10. Click Next. The Start Copying Files window appears.

Type a 
password
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Figure 3-32   Start Copying Files Window

11. Click Next. The InstallShield Wizard Complete window appears.
Figure 3-33   InstallShield Wizard Complete Window

12. Click Finish. The Integration package is installed.
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Verifying the CTI Integration
This procedure describes how to verify that all the relevant system components have been 
attached.

To verify that all system components have been attached:

1. In the System Administrator, in the Organization tree, navigate to Master Site > CTI 
Integrations and select CTI Integrations.

2. Click the Diagram tab. The following diagram appears.
Figure 3-34   CTI Integrations Diagram

NOTE: This diagram only displays the connection layout. IT DOES NOT notify you if the 
connection between the different components is established or not!
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4

Troubleshooting

This chapter describes the troubleshooting procedures for the NICE Interactions Center and the 
Avaya PD integration.

Contents

Troubleshooting .............................................................................................................62
Chapter 4: Troubleshooting
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Troubleshooting
The troubleshooting scenarios and solution procedures for the NICE Interactions Center and 
Avaya PD integration are described below.

Problem: The AvayaPDCTILink is not connecting

Solution:

• Check that all the connection plug-in parameters are correct. 

• Verify that you have entered the Event Service host name in the hosts file under 
c:\Windows\system32\drivers\etc. 

• Make sure that the Naming service and the Event service are up and running and that you 
can ping them from the NICE Interactions Center server.

Problem: Calls that should have been recorded can not be heard

Solution:

• Check the time synchronization of the different components of your system. Particularly 
make sure that the time on the computer on which you are attempting to listen to the call is 
synchronized with the time of the NiceLog Logger.

• Check your mapping in the channel mapping.

NOTE: The host name fields are case sensitive.

NOTE: The hosts file is also case sensitive.
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5

NICE Testing and Debugging Tools

This chapter describes several NICE testing and debugging tools which enable you to troubleshoot 
your site. Use the different tools to help you isolate problems.

Contents

NICE Events Spy.............................................................................................................64

NICE Debug Service .......................................................................................................69

Connection Manager Monitor ........................................................................................75

Log Manager System .....................................................................................................81

CAPI Spy..........................................................................................................................88

Enclient............................................................................................................................94

NOTE: All these tools should only be used by authorized personnel and in conjunction 
with NICE Systems.
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NICE Events Spy
NICE Events Spy enables you to trace events after they were transferred from the PABX to the 
Connection Manager, enabling you to detect bugs or malfunctions.

Setting Up the Events Spy

The NICE Events Spy tool is part of the NICE Perform Applications Suite.

To set up the NICE Events Spy Tool:

1. Open the System Administrator, as follows:

a. Login to the NICE Perform Applications Suite.

b. From the Accessories menu, choose System Administrator. 

The System Administrator appears with a list of NICE components under the Site branch 
in the Organization tree.

To add components in the System Administrator, you must work in Technician Mode.

2. Set the System Administrator to Technician Mode:

a. In the Organization Tree, select the Organization branch. 

b. Mark the Technician Mode checkbox and click Save .

3. In the Organization tree, navigate to Master Site > CTI Integrations > Connection 
Managers. Choose the Connection Manager for which you want to set up the NICE Events 
Spy tool.

4. Click the Interfaces tab and expand Configure Connection Manager - Interface 
Parameters.

WARNING
Using the NICE Events Spy can greatly increase the load on your system. The UseSpy 
parameter default is therefore No. Using the NICE Events Spy and changing the parameters 
should be performed only by authorized personnel and in conjunction with NICE Customer 
Support.
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NICE Events Spy

Figure 5-1   Interfaces Tab

5. Double-click the UseSpy parameter. The Set Parameter Value window appears.
Figure 5-2   Set Parameter Value Window

6. From the Value drop-down list, choose Yes and click OK.

7. Double-click the SpyMailSlot Name parameter. The Set Parameter Value window appears.
Figure 5-3   Set Parameter Value Window

Double-click UseSpy
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8. In the Value field, type the name of the mailslot that you want to use in conjunction with 
NICE Events Spy.

9. Click OK.

Receiving Events

You should set up the Events Spy so that you can receive events.

To use NICE Events Spy:

1. On the Interaction Center server, navigate to the Integrations folder (the default location is 
D:\NICECTI\Integrations). Double-click EventSpy.exe. The Events Spy window appears.
Figure 5-4   Events Spy Window

2. From the Connections menu, choose Mailslot Connections for Receiving Events > 
Open Mailslot. The Events Spy - Mailslot Name window appears.
Figure 5-5   Events Spy - Mailslot Name Window

3. Type the name of the mailslot you defined in setting up the NICE Events Spy tool. Click OK. 

TIP: It is recommended to use a short name.

NOTE: If the Connection Manager is running, you should restart it after setting these 
definitions.

Event Type 
Column
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The Events Spy begins to receive events from the switch. The events are listed in the Event 
Type column of the Events Spy window, see Figure 5-4.

Saving Events

NICE Events Spy enables you to:

• Create and save events in an active log file.

• Save all current events.

• Save selected current events.

You can save the files in either .xml or .bin formats. 

Saving Events in a Log File

This option enables you to create a log file that saves all events from the time you create the file 
until you close it.

To save events in a log file:

1. From the File menu, choose Log to File.

2. To create a log file using the .xml format, click Log to XML File. To create a log file using the 
.bin format, click Log to Binary File. The Save as window appears.

3. Save the file in any convenient location.

Saving Current Events

This option enables you to create a file in which you can save all events that currently appear in the 
Event Type column.

To save current events:

1. From the File menu, choose Save Current Events to File.

2. To create a file using the .bin format, click Save all Events to Binary File. To create a file 
using the .xml format, click Save all Events to XML File. The Save as window appears.

3. Save the file in any convenient location.

NOTE: To view the contents of any of the log files you created, from the File menu click 
Open Log File.
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Saving Selected Current Events

This option enables you to create a file in which you can save selected events from the list that 
currently appears in the Event Type column.

To save selected current events:

1. Select the events you want to save, clicking the events while holding down the <Ctrl> key.

2. From the File menu, choose Log to File.

3. To create a file using the .bin format, click Save Only Selected Events to Binary File. To 
create a file using the .xml format, click Save Only Selected Events to XML File. The Save 
as window appears.

4. Save the file in any convenient location.

Setting up the SimCTILink Tool

The SimCTILink tool simulates the transfer of events to the Connection Manager as if they 
originated in the PABX. This enables you to save and analyze them without having to actually use 
the PABX itself.

Sending Events

WARNING
Use of the SimCTILink tool must be coordinated in advance with NICE Systems and must be 
performed only by authorized personnel. DO NOT attempt to use this tool on your own.
You must therefore leave the parameter default value as No unless specifically instructed to do 
so by NICE Customer Support.

WARNING
You can send events to NICE Systems using the Events Spy window. Sending events is only 
done when using the SimCTILink tool, and must be coordinated in advance with NICE Customer 
Support.
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NICE Debug Service
The Debug Service enables you to gather data critical for solving problems stemming from the 
transfer of events between the switch and the Connection Manager.

This section includes the following topics:

• Setting Up the NICE Debug Service

• Accessing the NICE Debug Service

Setting Up the NICE Debug Service

The Debug Service enables developers and customer support personnel to reproduce problematic 
scenarios.

To set up the Debug Service:

1. Open the System Administrator, as follows:

a. Login to the NICE Perform Applications Suite.

b. From the Accessories menu, choose System Administrator. 

The System Administrator appears with a list of NICE components under the Site branch 
in the Organization tree.

To add components in the System Administrator, you must work in Technician Mode.

2. Set the System Administrator to Technician Mode:

IMPORTANT
Do not attempt to solve bugs or other problems yourself. Use the Debug Service in coordination 
with NICE Systems to gather the data as described below, and then send it to NICE Customer 
Support for assistance.

WARNING
Using the Debug Service can greatly increase the load on your system. The DebugServiceMode 
parameter default is therefore Idle. Using the Debug Service and changing the parameters 
should be performed only by authorized personnel and in conjunction with NICE Customer 
Support.
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a. In the Organization Tree, select the Organization branch. 

b. Mark the Technician Mode checkbox and click Save .

3. In the Organization tree, navigate to Master Site > CTI Integrations > Connection 
Managers. Choose the Connection Manager for which you want to set up the Debug Service.

4. Click the Interfaces tab and expand Configure Connection Manager - Interface 
Parameters.
Figure 5-6   Interfaces Tab

5. Double-click the DebugServiceMode parameter. The Set Parameter Value window appears.
Figure 5-7   Set Parameter Value Window

Double-click DebugServiceMode
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6. From the Value drop-down list, choose either Record or Debug (see following table) and 
click OK.

7. Define the Debug Service parameters according to the following table:

NOTE: You can also create and add additional parameters by clicking Add.

Table 5-1:  Debug Service Parameters 

Parameter Name Description Default Value

DebugServiceMode • Idle - the Debug Service is disabled.

• Record - the CTI Interface records every 
event, request, and response.

• Debug - the CTI Interface receives events, 
requests, and responses directly from the 
Debug Service (to be used only by NICE 
System personnel in lab environments).

Idle

DebuggingMode • Orignl_Intrvls - retains the original intervals 
between events that were used by the switch.

• Fixed_Intrvls - events are transferred to the 
link at fixed intervals, which are defined in the 
FixedTimeInterval parameter.

• Single_Step - events are transferred upon 
user input.

NOTE: This parameter is activated only when you 
activate the DebugServiceMode.

Single_step

RecordingMode • Asynchronous - synchronization of the 
requests and responses by the InvokeID is 
defined by the switch. Not applicable to TAPI.

• Semi_Synchronous - synchronization of the 
requests and responses by the InvokeID is 
defined by the Debug Service. Not applicable 
to TAPI.

• Simple - No synchronization is performed.

NOTE: This parameter is activated only when you 
activate the DebugServiceMode.

Asynchronous
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8. To activate the Debug Service after you have defined the above parameters, close the 
Connection Manager process in the Interaction Center server. The Debug Service is activated 
when the Dispatch Service automatically restarts the Connection Manager process.

DebugFilesFldr Defines the folder in which the files created by the 
Debug Service are saved.
NOTE: 

• It is highly recommended to delete the 
contents of the Debug folder before activating 
the Debug Service.

• This parameter is activated only when you 
activate the DebugServiceMode.

• The files are saved in binary format.

Debug

FixedTimeInterval Defines the value when you define Fixed_Intrvls 
as the value for the DebuggingMode parameter 
above.
NOTE: 

• The value is defined in seconds.

• This parameter is activated only when you 
activate the DebugServiceMode.

0

AvailableDiskQuota Defines the maximum size allowed on the hard 
disk for the Debug file you defined in the 
DebugFilesFldr above.

• The value is defined in MB.

• This parameter is activated only when you 
activate the DebugServiceMode.

300

Table 5-1:  Debug Service Parameters  (Continued)

Parameter Name Description Default Value
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9. The Debug Service transfers the event data to the file you defined in the DebugFilesFldr 
above.

For each debug session, the Debug Service automatically creates four debug files:

e_xxxxxxxxxx.dbg
e_xxxxxxxxxx.ndx
r_xxxxxxxxxx.dbg
r_xxxxxxxxxx.ndx

in which “xxxxxxxxxx” is the unique debug session identifier. The folder to which the above 
files are transferred is located in D:\NICECTI\Integrations\Debug (default), or in the 
location you defined in the DebugFilesFldr parameter above.

Accessing the NICE Debug Service

NICE Systems provides a utility for viewing the Debug files. You then send the four Debug files to 
NICE Customer Support.

To access the Debug files:

1. In the Interaction Center, navigate to the Integrations folder (the default location is 
D:\NICECTI\Integrations). 

2. In the Tools folder, double-click IntegrationFileSplitter.exe. The Integration File Splitter 
window appears.

IMPORTANT
You must send all four Debug files to NICE Customer Support. If any one of the Debug files is 
missing, the scenario cannot be reconstructed.

NOTE: To avoid confusion with any Debug files from previous sessions, it is highly 
recommended to delete all existing Debug file(s) before activating the Debug Service.



74 Chapter 5: NICE Testing and Debugging Tools

NICE Perform® Release 3: Integration with Avaya PD/PDS (Rev. A0)

NICE Debug Service

Figure 5-8   Integration File Splitter Window

3. Drag and drop the Debug files into the File Details area. The Debug files and the debug 
session identifier numbers appear in the File Details area. 

4. When necessary, you can open and view the contents of the .dbg files.

Drag and drop 
debug files 
into the File 
Details aras.

IMPORTANT
Make sure that you send to NICE Customer Support the four debug files that correspond to the 
debug session ID number.
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Connection Manager Monitor
The NICE Connection Manager Monitor tool enables you to view the contents of the Connection 
Manager’s tables. It also enables you to verify if:

• Devices are monitored

• Monitored devices are filtered

and

• Displays the loaded CTI links

• Displays connected clients.

Your next step is to connect the Connection Manager Monitor tool to the Connection Manager as a 
client. It then receives events in addition to monitoring devices, enabling you to conduct simple 
tests without running a driver.

This section includes:

• Managing the Connection Manager Monitor

• Stopping the Connection Manager Monitor

Setting Up the Connection Manager Monitor

To set up the Connection Manager Monitor, follow the procedures below.

To set up Connection Manager Monitor:

1. In the Interactions Center, navigate to the Integrations folder (the default location is 
D:\NICECTI\Integrations). Double-click ConnectionManagerMonitor.exe. The 
Connection Manager Monitor window appears.
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Figure 5-9   Connection Manager Monitor Window

2. From the Monitor menu, choose Connect. The Select Connection Manager window appears.
Figure 5-10   Select Connection Manager Window

3. Type the Connection Manager ID of the Interactions Center to which you want to connect. 
Click OK. The Connection Manager Monitor displays the contents of the Connection Manager 
tables.

Type the Connection Manager 
ID of the Interactions Center 
to which you want to connect
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Figure 5-11   Connection Manager Window - Tables

4. From the Client menu of the Connection Manager Monitor window, choose Connect. The 
Select Connection Manager window appears.
Figure 5-12   Connection Manager Window - Client Menu

5. Type the Connection Manager ID of the Interactions Center to which you want to connect. 
Click OK.

After the Connection Manager Monitor establishes connection to the desired Connection 
Manager, the Monitor, Stop Monitor, and Disconnect options in the Client menu become 
enabled. The Client connection appears in the Clients area.

Type the Connection Manager 
ID of the Interactions Center 
to which you want to connect
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Figure 5-13   Connection Manager Monitor - Client Connection in Clients Area

6. From the Client menu, choose Monitor. The Monitor Device window appears.
Figure 5-14   Monitor Device Window

a. In the Device ID field, type the Device ID number of the Connection Manager to which 
you want to connect.

b. In the Switch ID field, type the Switch ID number.

c. From the Device Type drop-down list, choose the appropriate device type.

d. Click Monitor. The response appears in the Output area.

Client 
connection
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Figure 5-15   Output Area

7. Click Update. The new Client appears in the Client Device Requests area.
Figure 5-16   Connection Manager Monitor - Client Device Requests Area

IMPORTANT
The Connection Manager Monitor window does not continuously refresh the data displayed in 
the window; it only displays the data current at the time you establish the connection. To update 
the data displayed in the window, click Update.

New Client
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Managing the Connection Manager Monitor

This section includes the following topics:

• Stopping the Connection Manager Monitor

• Disconnecting the Connection Manager Monitor Client

Stopping the Connection Manager Monitor

This procedure describes how to stop the Connection Manager Monitor when it is functioning as a 
client.

To stop the Connection Manager Monitor:

1. From the Client menu of the Connection Manager Monitor window, choose Stop Monitor. 
The Stop Monitor Device window appears.
Figure 5-17   Stop Monitor Device Window

2. Type the Device ID number and the Switch ID of the device you want to stop monitoring.

3. Click Stop Monitor. The response appears in the Output area.

Disconnecting the Connection Manager Monitor Client

This procedure describes how to disconnect the Connection Manager Monitor when it is 
functioning as a client.

To disconnect the Connection Manager Monitor Client:

• From the Client menu of the Connection Manager Monitor window, choose Disconnect.

The Client connection of the Connection Manager no longer appears in the Clients area and in 
the Client Device Requests area.
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Log Manager System
The Log Manager system logs all significant system activity and maintains a log of all data, 
enabling you to view the history of all relevant system activity. 

The Log Manager system has four main components:

• CTI Console Viewer

• Log Manager

• Log Manager Services

• Log Viewer

CTI Console Viewer
The CTI Console Viewer enables real-time log tracking of the screens of all integration 
components installed on the local machine. This application replaces the Console windows in the 
Reporting Level of the integration process, and provides the user with filtering capability. 

CTI Console Viewer has a separate window for each integration process. You can view and filter 
an event, as well as change the reporting level. You cannot do this in the System Administrator. 
Files are saved automatically in the Log Manager and can be viewed afterwards in the Log Viewer. 
Figure 5-18   CTI Console Viewer

To open the CTI Console viewer: 

• To open, double-click the icon in the system tray. 

-or-

• Right-click the icon, and select Open NICE CTI Console Viewer. 
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To open a specific integration process window:

1. From the CTI Modules menu, choose the relevant integration process.

A log window opens and the integration modules installed on the local machine are listed. 
(This list is updated when you add/remove any integration modules in the System 
Administrator).

Figure 5-19   CTI Log Window 

Filtering Messages

You can filter messages in any of the following manners:

NOTE: These reporting levels are only relevant for the CTI Console. 

WARNING
Reporting levels may be helpful for troubleshooting. However, making changes to the reporting 
levels can greatly add to the load on your system. Changing reporting levels should therefore be 
done only by authorized personnel and in conjunction with NICE Customer Support.

• Reporting level - Clear the checkboxes of the reporting levels that are irrelevant (message 
importance).
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To reset the filter: 

• Click the Reset Filter button.

The filter in Module Name and Thread ID is reset, and all the messages are printed. (The Reset 
filter option does not affect the reporting level).

To clear the screen of messages: 

• Click the Clear Screen button.

All the messages are cleared from the screen.

To open the last log file: 

• Click the Open last log file button.

The current log file with Log Viewer opens (see Log Viewer section). You can see log 
messages from the specific modules in real-time as they are displayed.

To change console size and color:

1. From the Options menu, choose Console size.

When the log window is filled with the maximum number of messages, the top rows are 
automatically deleted.

2. From the Options menu, choose Change color. 

 a. Select a background color.

 b. Select a color for each reporting level. 

• Module name - Clear the checkboxes of any modules that are irrelevant.

• Thread ID - Clear the checkboxes of any Thread IDs that are irrelevant.

NOTE:  The filter is applied to new messages. It does not affect old messages.
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Log Manager

The Log Manager creates log message files and/or sends information regarding the Console and 
the Event Log according to the predefined Reporting Level filter. 

You can set the reporting levels in any of the integration branches e.g. in the Connection 
Managers, in the Drivers, in the Key Managers, in the Media Provider Controllers (Observers), or 
in the New Driver wizards when you initially set up the driver. 

By default, reporting levels are defined for the following:

• Console - reports to the standard Console window

• File - reports to the Log file located in the Integrations installation folder

• Event Log - reports to the Log files located in the Event Viewer

If necessary, you can also manage the size of the log files, the amount of disk space dedicated to 
them, and the number of days you wish to keep log files. 

To define the reporting levels:

1. Open the System Administrator, as follows:

a. Log in to the NICE Perform Applications Suite.

b. From the Accessories menu, choose System Administrator. 

The System Administrator appears with a list of NICE components under the Site branch 
in the Organization tree.

To add components in the System Administrator, you must work in Technician Mode.

WARNING
Reporting levels may be helpful for troubleshooting. However, making changes to the reporting 
levels can greatly add to the load on your system. Changing reporting levels should therefore be 
done only by authorized personnel and in conjunction with NICE Customer Support.

NOTE: The Event Viewer is a Microsoft feature which can be viewed under the 
Control Panel > Administrative Tools.
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2. Set the System Administrator to Technician Mode:

• In the Organization Tree, select the Organization branch. 

3. Mark the Technician Mode checkbox and click Save .

4. You can set the Reporting Level in any of the branches, see the examples below:

• In the Organization tree, expand Master Site > CTI Integrations > Connection 
Managers and click the relevant Connection Manager. In the Connection Manager 
Details area, expand Reporting Level.

-or-

• In the Organization tree, expand Master Site > CTI Integrations > Drivers. In the 
Driver General Information area, expand Driver Reporting Level.

Figure 5-20   Driver Reporting Level Area

5. Choose the desired row and click Edit . The Set Reporting Level window appears.
Figure 5-21   Set Reporting Level Window

Click Edit
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6. Mark the checkboxes for the reporting levels you want to include and click OK.

7. In the relevant log field, type the new setting and click Save . 

Log Manager Services

The Log Manager’s second module can be found in Services. It consists of two log manager 
related services:

• Nice Integration Log Retention

• Nice Integration Reporting Level Dumper

Log Viewer

The Log Viewer enables you to view the log files and to filter them. You can keep several logs 
open at the same time. 

Filtering Logs

You can filter the logs according to the following criteria:

• Reporting level: Clear the reporting levels that are irrelevant.

• Date: Choose the appropriate time range.

• Module name: Unmark any modules that are irrelevant.

• Thread ID: Unmark any thread IDs that are irrelevant.

• Message: Type any relevant message.

To filter a log file:

1. In the Interaction Center, navigate to the Tools folder (the default location is 
D:\NICECTI\Integrations\Tools). 

2. Double-click LogViewer.exe. The Log Viewer window appears.

3. Using Windows Explorer, select the relevant log files and drag them to the Log Viewer.

4. In the Filter area, mark the relevant filter options.

NOTE: It is highly recommended that you do not change the settings of the default 
reporting levels. Changing reporting levels should be done only by authorized 
personnel and in conjunction with NICE Customer Support.

WARNING
You should not change any values in the Registry. All changes should be made through the 
System Administrator application and be done only by authorized personnel and in conjunction 
with NICE Customer Support.
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Figure 5-22   Log Viewer Window

5. Click Filter. The filtered logs appear in the Log Viewer window.

6. To save the filtered log file for future reference: from the File menu, choose Save as. The 
Save as window appears.

7. Name the filtered log file appropriately.

Searching Logs

The Log Viewer enables you to search for specific text within a specific column or within all 
columns. The Log Viewer remembers past searches.

To search for a specific text value:

1. From the Edit menu, choose Find. The Find window appears.
Figure 5-23   Find Window

2. Click the In column drop-down list and choose the relevant search basis.

3. Click Find next.

Click 
Filter
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CAPI Spy
The CAPI Spy enables you to monitor all messages sent by the CTI driver to the CLS CAPI (Call 
Server). Examination of these messages enables you to pinpoint whether the problem is in the CTI 
driver or in the CLS CAPI server.

CAPI Spy has two main components: 

• CAPI Spy Plug-in

• CAPI Spy Utility

CAPI Spy Plug-in

The CAPI Spy plug-in is one of the standard CTI driver plug-ins. You set it up in the System 
Administrator. Only marked plug-ins are executed by the CTI driver.

To set up the CAPI Spy Plug-in:

1. Open the System Administrator, as follows:

a. Login to the NICE Perform Applications Suite.

b. From the Accessories menu, choose System Administrator. 

The System Administrator appears with a list of NICE components under the Site branch 
in the Organization tree.

To add components in the System Administrator, you must work in Technician Mode.

2. Set the System Administrator to Technician Mode:

a. In the Organization Tree, select the Organization branch. 

b. Mark the Technician Mode checkbox and click Save .

3. In the Organization tree, navigate to Master Site > CTI Integrations > Drivers. Click the 
relevant driver. 

4. Click the Interfaces tab.
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Figure 5-24   Drivers > Interfaces Tab

5. In the Attach CTI Interfaces section, click the relevant interface driver and click Configure. 
The Driver - Interface Configuration window appears.
Figure 5-25   Driver - Interface Configuration Window

6. Expand Driver Real-Time Plugins.

IMPORTANT
You can mark CAPISpy once and then leave it marked, as it has no negative impact on the 
system.
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Figure 5-26   Driver Real-Time Plugins Area

7. Mark the CAPISpy checkbox and click OK.

8. Click the General tab and expand Additional Driver Parameters. The Additional Driver 
Parameters area displays.
Figure 5-27   Additional Driver Parameters Area

Click the 
arrows to 
change the 
order.

NOTE: It is highly recommended that CAPISpy should be the last entry in the Driver Real-Time 
Plugins list. This enables you to see any changes that may have come about because of other 
plugins.
You can change the order of the drivers by clicking the arrows.
After you mark or unmark the CAPISpy checkbox, you must restart the driver before the change 
will take effect.
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9. Define the CAPI Spy parameters according to the following table:

10. Click Save .

CAPI Spy Utility

NICE Systems provides a utility for viewing the CAPI Spy messages in XML format. 

To set up the CAPI Spy:

1. In the NICE Interactions Center, navigate to the Integrations folder (the default location is 
D:\NICECTI\Integrations). Double-click CAPISpy.exe. The CAPI Spy window appears.
Figure 5-28   CAPI Spy Window

Table 5-2:  CAPI Spy Parameters

Parameter Name Description Default Value

CAPISpyServerPort Port to which the CAPI Spy connects.
NOTE: You should not change the value of this 
parameter unless there is another third party 
application that uses this port.

If the value is changed, restart the driver. 
Then configure the CAPI Spy application to 
connect to the new port. See Changing 
Connection Details.

7002

CAPISpyMessageQueueSize Size of message queue in CAPI Spy 
server.

NOTE: Be careful about setting this to a higher 
value as it can slow driver performance.

50
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2. From the Connect menu, choose Connect to CTI Driver.

After the CAPI CTI driver and the CAPI Spy utility are connected, the CAPI Spy starts 
displaying CAPI messages.
Figure 5-29   CAPI Spy Window Displaying Messages

NOTE:  If the connection is not successful, an error message appears. Contact NICE Customer 
Support.
If the connection is dropped, an error message appears. To reconnect the connection, from the 
Connect menu, choose Connect to CTI Driver.
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Changing Connection Details

The CAPI Spy by default connects to the localhost CTI driver on the 7002 port. When port 7002 is 
used by another third party application, you can change the port. See CAPI Spy Plug-in.

To change the connection details:

1. From the Connect menu, choose Change connection details. The Connection Details 
window appears.
Figure 5-30   Connection Details Window

2. Type the Driver IP Address and the Driver Spy port.

3. Click OK.

NOTE: You can also monitor CAPI messages from a different host. In this case, type the IP 
address of the remote machine. This can seriously overload the network and should be avoided 
if possible.
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Enclient
This is a debugging tool for Avaya PD. To run the tool, follow the procedures below.

To run the Enclient debugging tool:

1. In the Interactions Center, navigate to the Integrations folder (the default location is 
D:\NICECTI\Integrations). Double-click enclient.exe. The Enclient window appears.
Figure 5-31      Enclient Window - Enter Version

2. Type the version of Avaya PD - 12 or PC3. Press <Enter>.
Figure 5-32      Enclient Window - Event Server Host Name

3. Type the name of the Event Server host name. Press <Enter>.
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Figure 5-33      Enclient Window - Naming Service Host Name

4. Type the name of the Avaya PD Naming Service host name. Press <Enter>.
Figure 5-34      Enclient Window

5. Send log files and dump files to NICE Customer Support. 

NOTE: Allow Enclient to run as recommended by NICE Customer Support.
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CTI Interface - Switch Connection Details Parameters
CTI Interface - Switch Connection Details Parameters

Additional Parameters for configuring the CTI Interface are located in the Switch Connection 
Details of the CTI Interface wizard (see Configuring the CTI Interface on page 36).
Figure A-1   Switch Connection Details Window

The following predefined additional parameters appear for Avaya PD’s Switch Connection 
Details. To change the default parameters, follow the procedures below.

WARNING
Changing parameters may have severe effects on your system. Therefore changing the CTI 
Interface Additional Parameters, or creating new ones, should be done only by authorized 
personnel and with authorization by NICE Customer Support.

NOTE: You can also create and add additional parameters by clicking Add.

Parameter Name Description Default 
Value

AvayaPD Version Indicates the Avaya PD version you are 
using. Choose either 12 or PC3.

12

AvayaPD Server IP address Indicates the Avaya PD network IP 
address.

Client Port ID Indicates the switch connection’s port ID. 66666
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CTI Interface - Switch Connection Details Parameters
* Contact your Avaya site administrator for this information.

To change the default values:

1. Double-click the row of the relevant parameter. The Switch Connection Parameter window 
appears.
Figure A-2   Switch Connection Parameter Window

2. In the Value field, type the desired value.

3. Click OK.

Event Service Server Host 
Name

Indicates the event service host name. 

Naming Service Host Name Indicates the naming service host name.

AvayaPD Client Username Defines the protocol setting according to 
the version number.

client1*

AvayaPD Client Password Indicates the client peripheral number 
that matches the PABX connected to the 
ICM.

*

Parameter Name Description (Continued) Default 
Value
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CTI Interface - Additional Switch Parameters
Additional Parameters for configuring the CTI Interface are located in the Additional Switch 
Parameters window of the CTI Interface wizard (see Configuring the CTI Interface on page 36).
Figure A-3   Additional Switch Parameters Window

The following predefined additional parameters appear for Avaya PD’s Additional Switch 
Parameters:

Parameter Name Description Default Value

LinkFiFoSize Defines the size of the FiFos in the link. 1000

LinkSafeTableSize Defines the size of the safe tables in the link. 2500

MaxAgents Defines the maximum agents allowed. 5000

MonitorJobEvents Defines whether to monitor job events. No

MinCallID Defines the minimum number of Call IDs with 
which the link will start reporting. 

1

MaxCallID Defines the maximum number of Call IDs with 
which the link will start reporting.

200000

NOTE: Ensure that you have a range of at least 10,000 between the minimum and 
maximum Call ID numbers. 
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To change the default values:

1. Double-click the row of the relevant parameter. The Driver Additional Parameter window 
appears.
Figure A-4   Driver Additional Parameter Window

2. In the Value field, type the desired value.

3. Click OK.
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Reporting Levels

Reporting Levels are defined in the General Information window of the Connection Manager and 
the New Driver wizards, see Configuring the Connection Manager on page 42 and Defining 
the Driver on page 46.
Figure A-5   Reporting Level Area

By default reporting levels are defined for the following:

• Console - reports to the NICE Log Manager

• File - reports to the Log file located in the Integrations installation folder

• Event Log - reports to the Log files located in the Event Viewer

WARNING
Reporting Levels may be helpful for troubleshooting. However, making changes to the Reporting 
Levels can greatly add to the load on your system. Changing Reporting Levels should therefore 
be done only by authorized personnel and in conjunction with NICE Customer Support.

NOTE: The Event Viewer is a Microsoft feature which can be viewed under the 
Control Panel > Administrative Tools.
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Reporting Levels
To define reporting levels:

1. Choose the desired row and click Edit. The Set Reporting Level window appears.
Figure A-6   Set Reporting Level Window

2. Mark the checkboxes for the reporting levels you want to include and click OK.
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Connection Manager - Additional Parameters

Additional Parameters for configuring the Connection Manager are located in the General 
Information window of the Connection Manager wizard, see Configuring the Connection 
Manager on page 42.
Figure A-7   Additional Parameters Area

The following predefined additional parameters appear:

WARNING
Changing parameters may have severe effects on your system. Therefore changing the 
Connection Manager Additional Parameters, or creating new ones, should be done only by 
authorized personnel and with authorization by NICE Customer Support.

NOTE: You can also create and add additional parameters by clicking Add.

Parameter Name Description Default 
Value

MaxClientDeviceRequests Defines the maximum number of device 
requests that Connection Manager can 
handle.

1000

MaxClientRequests Defines the maximum number of client 
requests that Connection Manager can 
handle.

1000
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Connection Manager - Additional Parameters
To change the default value:

1. Double-click the row of the relevant parameter. The CM Additional Parameter window 
appears.
Figure A-8   CM Additional Parameter Window

2. In the Value field, type the desired value and click OK.

MaxClients Defines the maximum number of clients 
that can be attached to Connection 
Manager.

100

MaxMonitoredDevices Defines the maximum number of monitored 
devices up to which the Connection 
Manager can handle. For example, if the 
value is 1000 the Connection Manager can 
handle 999 monitored devices.

1000

MaxSwitchIdToCTILinkEntries Defines the maximum number of CTI links 
Connection Manager can handle.

10

Parameter Name Description (Continued) Default 
Value
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Connection Manager - Interface Parameters

Interface parameters for the Connection Manager are located in the Connection Manager Switches 
Information window of the Connection Manager wizard, see Configuring the Connection 
Manager on page 42.

Configure Connection Manager - Interface Parameters

The Connection Manager - Interface has its own predefined parameters. 

Figure A-9   Configure Connection Manager - Interface Parameters Area

WARNING
Changing parameters may have severe effects on your system. Therefore changing the 
Connection Manager Interface Parameters, or creating new ones, should be done only by 
authorized personnel and with authorization by NICE Customer Support.

NOTE: You can also create and add additional parameters by clicking Add.
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The following predefined additional parameters appear:

* For details, see NICE Events Spy on page 64.

** For details, see Setting up the SimCTILink Tool on page 68.

To change the default value:

1. Double-click the row of the relevant parameter. The CM Additional Parameter window 
appears.

Parameter Name Description Default 
Value

DllName The name of the DLL that contains the CTI 
Link translator. This DLL is dynamically 
installed when you define a new Connection 
Manager.

Read-only

LoadDllOneTimeOnly Defines the way the driver treats the link in a 
multi-link configuration.

KeepAliveInterval Defines the Keep Alive Interval time. The 
value is defined in seconds.

30

UseSpy* Defines if the Connection Manager reports 
link events to the NICE Events Spy tool.*

No

SpyMailSlotName Defines the name of the mailslot between 
the Connection Manager and the NICE 
Events Spy tool. 
IMPORTANT: Define this parameter only if 
you defined Yes for the UseSpy parameter.

UseSimCTILink** Defines if the Connection Manager uses the 
SimCTILink tool to read events.**

No

SimMailSlotName Defines the name of the SIM mailslot 
between the Connection Manager and the 
Spy tool. 
IMPORTANT: Define this parameter only if 
you defined Yes for the UseSimCTILink 
parameter.
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Figure A-10   CM Additional Parameter Window

2. In the Value field, type the desired value and click OK.
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Driver - Additional Driver Parameters

Additional parameters for configuring the Driver are located in the General Information window 
of the New Driver wizard, (see Defining the Driver on page 46).
Figure A-11   Additional Driver Parameters Area

The following predefined additional parameters appear:

WARNING
Changing parameters may have severe effects on your system. Therefore changing the Driver 
Additional Parameters, or creating new ones, should be done only by authorized personnel and 
with authorization by NICE Customer Support.

NOTE: You can also create and add additional parameters by clicking Add.

Parameter Name Description Default 
Value

MaxCapiCommandRetries Defines the number of times the driver 
attempts to send a command to the CAPI 
following a failure.

4

MaxNumberOfCalls Defines the maximum number of calls in the 
concurrent calls buffer.

5000

CAPISpyServerPort Defines the port to which the CAPI spy 
application connects.

7002
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To change the default value:

1. Double-click the row of the relevant parameter. The Driver Additional Parameter window 
appears.
Figure A-12   Driver Additional Parameter Window

2. In the Value field, type the desired value and click OK.

CAPISpyMessageQueueSize Size of the message queue in the CAPI Spy 
server.

50

UseEventDB Defines if the driver uses the EventDB 
database for CTI Analysis.

No

DelayBetweenStartFailed
LinksInSeconds

Defines the amount of time before the driver 
reconnects to the CTI link following a failure. 
The value is defined in seconds.

30

MaxCallDurationSec Defines the maximum time the driver allows a 
call to last until it is automatically 
disconnected. The value is defined in 
seconds.

7200

UseCTIAnalysis Defines if CTIA is in use in the driver. No

CallTableHost Host name of the Call Table. localhos
t

CallTablePort Port number of the Call Table. 7272

AlwaysConnecttoLocalCLS Defines if the driver always connects to the 
NICE Interactions Center on the local machine 
regardless of the NICE Interactions Center’s 
real address. 
Useful when working with CLS as a cluster.

No

Parameter Name Description (Continued) Default 
Value
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Driver - CTI Analysis Parameters

CTI Analysis parameters for configuring the Driver are located in the General Information 
window of the Driver wizard, see Defining the Driver on page 46.
Figure A-13   CTI Analysis Parameters Area

The following predefined CTI Analysis parameters appear:

WARNING
Changing parameters may have severe effects on your system. Therefore changing the Driver 
CTI Analysis Parameters, or creating new ones, should be done only by authorized personnel 
and with authorization by NICE Customer Support.

NOTE: You can also create and add additional parameters by clicking Add .

Parameter Name Description Default 
Value

HostName Host name for the Analyzer server. localhost

Port Port for the Analyzer server. 4003

NumberOfCompoundsToBulk Defines the number of compounds to 
bulk insert on each set.

50

TimeOutToPerformBulkInsert Defines the number of milliseconds as 
timeout to perform bulk insert.

600000
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Driver - CTI Analysis Parameters
To change the default value:

1. Double-click the row of the relevant parameter. The Driver CTIA Parameter window appears.
Figure A-14   Driver CTIA Parameter Window

2. In the Value field, type the desired value and click OK.

SQLTimeoutForBulkInsert Defines the number of seconds of SQL 
timeout for bulk insert.

60

DBFileSizePrecentAlarm Defines the warning percentage size of 
the nice_cti_analysis database file. 
When this size is reached, an alarm is 
sent.

95

DBTransactionLogSizeAlarm Defines the warning percentage size of 
the nice_cti_analysis transaction log 
file. When this size is reached, an alarm 
is sent.

95

DBFileSizesMonitorInterval Defines the interval time (in minutes) to 
monitor the database file sizes.

10

Parameter Name Description (Continued) Default 
Value
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Driver Interface - Additional Driver Switch Parameters

Additional Parameters for configuring the Driver Interface are located in the Driver Interface 
Configuration window of the New Driver wizard, see Defining the Driver on page 46.
Figure A-15   Additional Driver Switch Parameters Area

The following predefined additional parameters appear:

WARNING
Changing parameters may have severe effects on your system. Therefore changing the 
Additional Driver Switch Parameters, or creating new ones, should be done only by authorized 
personnel and with authorization by NICE Customer Support.

NOTE: You can also create and add additional parameters by clicking Add.

Parameter Name Description Default 
Value

op_EnableFlushCalls Defines if the driver flushes open calls when 
initializing connection.

Yes

SaveOriginalMapDevice Defines if the driver reports to the source 
device.

No

HandleAgentActivityOnly Defines if the driver handles login/logout 
events only from this link.

No

TimeOut Defines the response time for a request. The 
value is defined in milliseconds.

3000
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To change the default value:

1. Double-click the row of the relevant parameter. The Driver Additional Parameter window 
appears.
Figure A-16   Driver Additional Parameter Window

2. In the Value field, type the desired value and click OK.

MilliDelayBetweenCTIReque
sts

Defines the waiting time between CTI 
requests. The value is defined in milliseconds.

100

CTIRequestsRetries Defines the number of times the CTI tries to 
request events for Query and Monitor 
devices.

2

MilliDelayBetweenGetLink
StatusRequests

Defines the waiting time between “Get Link 
Status” requests. The value is defined in 
milliseconds.

5000

GetLinkStatusRetries Defines the number of times “Get Link Status” 
requests can be made.

4

FailedMonitoredThread
MinutesDelay

Defines the waiting time before reactivating a 
thread to monitor devices that the link had 
previously failed to monitor. The value is 
defined in minutes.

10

Parameter Name Description (Continued) Default 
Value
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Avaya Predictive Dialing System Events

This appendix provides general information about call and agent events generated by Avaya PDS.
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Typical Agent Workflow in a Contact Center

Typical Agent Workflow in a Contact Center
Many contact centers with the Avaya PDS also use an Avaya switch for handling inbound call 
routing for strictly inbound agents as well as for blended agents. 

Following is a typical Avaya PDS workflow in a contact center:

1. The agent logs into an Avaya phone using his regular telephone extension. 

2. The agent logs into Avaya PDS via his soft phone. 

3. The Avaya PDS application server registers the agent and assigns him an Agent ID.

4. Avaya PDS initiates a call back to the agent’s extension. The agent completes the login 
process when he answers this call.

This port stays off-hook and captures the agent for an outbound session.

5. Avaya PDS initiates an outbound call for the agent.

6. The agent is notified that he or she will receive outbound calls.

7. The agent starts to receive outbound calls.

Referring to the workflow above, when the agent logs into the Avaya switch, the Call Server 
receives the Agent ID and Station information. When the agent logs into the Avaya PDS, 
Avaya PDS reports the Station only to the Call Server. When the agent answers an outbound 
call, Avaya PDS reports the extension, enabling the Call Server to match the Station to the 
Agent ID received from the Avaya switch. 

Possible Agent Event Scenarios

When an agent interacts with a customer and/or a customer’s file, he progresses through different 
states in the Avaya PDS. These states may include:

• Not being logged into the Avaya PDS

• Being logged into the Avaya PDS but not attached to a specific job

• Being attached to a job but not available for work

• Being attached to a job, being available for work, but not ready for a call

• Waiting for a call

• Receiving a call

These agent states are depicted in Figure B-1.
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Typical Agent Workflow in a Contact Center

Figure B-1   Schematic Diagram of Agent States
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